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1. Vigtigt

Denne elektroniske brugervejledning er
beregnet til alle, der bruger Philips-skeermen.
Tag den tid du behgver for at laese vejledningen,
inden du bruger skaermen. Den indeholder
vigtige oplysninger om bemarkninger angdende
brugen af din skaerm.

Philips garanti deekker under forudsatning af,

at produktet behandles korrekt og anvendes til
det tilsigtede formal i overensstemmelse med
dens brugervejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kabsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og
vedligeholdelse

O Advarsler

Anvendelse af betjeningselementer, justeringer
eller fremgangsmader, der ikke er beskrevet i
denne dokumentation, kan resultere i elektrisk
sted, elektriske ulykker og/eller mekaniske ulykker:

Lees og felg disse vejledninger, nar du tilslutter
og anvender din computerskarm:

Betjening

* Hold skeermen vek fra direkte sollys,
meget kraftige lyskilder savel som andre
varmekilder Lengerevarende udsattelse
for denne slags forhold kan medfere
misfarvning og beskadigelse af skaermen.

* Fjern alt, der kan risikere at falde i
ventilationsabningerne eller forhindre
korrekt afkgling af skeermens’ elektronik.

* Bloker ikke ventilationsabningerne pa
kabinettet.

* Under placering af skeermen skal du sikre
dig, at det er let at komme til stremstikket
og stikkontakten.

*  Hvis der slukkes for skeermen ved at fjerne

stremkablet eller jeevnstrgmsledningen,
skal du vente 6 sekunder, for du satter

stremkablet eller jeevnstrgmsledningen til
igen for at opnd normal betjening.

* Brug altid et godkendt strgmkabel, der
er leveret af Philips. Hvis du mangler dit
stremkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

*  Udset ikke skaermen for kraftige
vibrationer eller stad under anvendelse.

*  Sld ikke pa skeermen, og undga at tabe den
under brug eller transport.

Vedligeholdelse

* Som en beskyttelse af skeermen skal du
undga at trykke kraftigt pa LCD skeermen.
Nar du flytter din skeerm, sa tag fat
om rammen for at lgfte den. Laft ikke
skaermen ved at sette din hand eller fingre
pa LCD skarmen.

* Tag stikket ud fra skeermen, hvis du ikke
skal bruge den i en lengere periode.

* Tag stikket ud at kontakten til skaermen,
hvis du skal renggre den med en let fugtet
klud. Skeermen kan terres af med en ter
klud, nar der er slukket for strammen.
Under alle omstaendigheder; ma der ikke
bruges organiske oplasningsmidler til
rengering af din skaerm.

» For at undga risiko for elektrisk sted eller
permanent beskadigelse af anlaegget, ma du
ikke udszette skeermen for stev, regn, vand
eller miljger med hgj fugtighed.

*  Huvis din skaam bliver vad, skal den tarres af
med en ter klud sa hurtigt som muligt.

e Hvis der kommer fremmed substans eller
vand ind | skeermen, sa sluk straks for
stremmen og tag stikker ud. Fjern derefter
den fremmede substans eller vandet, og
send skarmen til servicecenteret.

e Skermen ma ikke bruges eller opbevares pa
steder; hvor den udsattes for varme, direkte
sollys eller ekstrem kulde.

* Forat opretholde den bedste ydelse
af din skeerm og for langvarig brug,
bedes du bruge skeermen et sted, der



er indenfor fzlgende temperatur- og
fugtighedsomrade.
e Temperatur: 0-40°C 32-95°F
*  Fugtighed: 20-80 % RH

*  VIGTIGT: Serg altid for at aktivere
en pauseskeerm, der beveeger sig, nar
skaermen efterlades uden at blive anvendt.
Du skal altid bruge en pauseskaerm
eller et andet program, der opdaterer
skarmen regelmassigt, hvis skaermen
viser statisk materiale i lengere perioder.
Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage "“brandmarker”,
ogsa kendt som “efterbilleder” eller
“spegelsesbilleder” pa skaermen.

“Breendmaeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt
feenomen i LCD skaermteknologi. | de
fleste tilfzelde vil “brandmarkerne’” eller
“efterbilledet” eller “spagelsesbilledet”
forsvinde gradvist, efter skaermen er
blevet slukket.

O Advarsel

Alvorlig “brandmeerkerne’- eller “efterbillede”-
eller “spggelsesbillede”-symptomer forsvinder
ikke og kan ikke repareres. Ovennzvnte skade
er ikke deekket af garantien.

Service
e Kabinettet ma kun dbnes af kvalificeret
servicepersonale.

* Hvis der er behov for et dokument til
reparation eller integration, sa kontakt
dit lokale servicecenter. (Se kapitel om
"Kundeinformationscenter”)

* For oplysninger om transport, se
“Tekniske specifikationer”.

» Efterlad ikke din skeerm i en bil/bagagerum
under direkte sollys.

& Bemark

Kontakt en servicetekniker; hvis skaermen ikke
fungerer korrekt, eller hvis du er usikker pa,
hvad du skal gare, nar betjeningsinstruktionerne,
der er givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser

Felgende underafsnit beskriver de
notationsmaessige konventioner, der benyttes i
dette dokument.

Bemarkninger, forholdssregler og advarsler

I hele denne vejledning kan tekstafsnit veere
ledsaget af et ikon, og sta med fed eller kursiv
skrift. Disse afsnit indeholder bemaerkninger og
punkter, hvor der skal udvises forsigtighed, eller
advarsler: De anvendes som fglger:

& Bemark

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan gere bedre brug af
computersystemet.

0 Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab
af data.

O Advarsel
Dette ikon angiver risiko for personskader; og
hvordan dette undgas.

Visse advarsler kan optreede i andre formater,
og er eventuelt ikke ledsaget af et ikon. |
sadanne tilfelde er den givne udformning af
advarslen lovmaessigt obligatorisk.



1.3 Bortskaffelse af produkt og
emballage

Elskrot WEEE (Waste Electrical and Electronic
Equipment)

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/
sustainability/recycling.



2 Opszetning af skeer'm Bl Installation af stander

1. Anbring skeermen med forsiden vendt
nedad pa en bled og jeevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

2.1 Installation

a Emballagens indhold

=]
Start

PHILIPS

2. Hold pa foden med begge hzender, og sat
med en fast hdnd foden ind i fodsgjlen.

) (1) Fastsger forsigtigt foden til fodsgjlen
oS indtil lasen laser den pa plads.

(2) Brug dine fingre til at fastspaende skruen
under foden, og serg for at foden er
ordentlig fastspeendt pd sgjlen.

DvI

L

Lydkabel (237E3QPH)




E Tilslutning il PC
Model 237E3Q:
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@ AC stromindgang

© VGA-indgang

© DVI-D-indgang

O Kensington anti-tyverisikring

Model 237E3QPH:

PHILIPS
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@ AC stromindgang

© VGA-indgang

© HDMI indgang

© HDMI lydudgang

© Kensington anti-tyverisikring

o ©

Tilslutning til pc

1.

Tilslut ledningen ordentligt pa bagsiden af
skaermen.

Sluk for computeren og tag netledningen
ud af stikket.

Slut skeermens signalkabel til videostikket
bag pa computeren.

Seet computerens og skaermens
netledninger til et stik i naerheden.

Teend for computeren og skaermen. Hvis
skaermen viser et billede, er installationen
gennemfort.



2.2 Brug af skaerm

Model 237E3QPH:

— (5]
/v /A SENSOR/ /0K 0}
| | [\ | I
(7] (6] o O (2] o
(1) ()  |Tender og slukker for skeermen.
''''' - J Sédan far du adgang til OSD-
0 S/0K menuen.
) < Ga tilbage til det forrige OSD-
niveau.
El Produktbeskrivelse set forfra . . .
Model 237E30: Indstil sensorniveauet pa
ode Q: © | SENSOR |den automatiske justering af
Py baggrundslyset.
© A V [Tiljustering i skermmenuen.
I
Elrmv {l’)/A }@/4\ @iOK L|) O | -©® |[Skiftertilslutningskilden.
o e © © o o Smartlmage Lite. Der kan veelges
@ | E |mellem tre funktioner: Standard,
Internet og Game (Spil).
(1] ()  |Tender og slukker for skarmen.
Sédan far du adgang til OSD-
0 B/0K menuen.
Ga tilbage til det forrige OSD-
o < niveau.
O | [ [Skifter visningsformat.
© | AV [Tiljustering i skeermmenuen.
O  © [Skifter tilslutningskilden.
Smartlmage Lite. Der kan velges
0 @Y  |mellem tre funktioner: Standard,
Internet og Game (Spil).




Bl Beskrivelse af OSD-visningen
Hvad er OSD (On-Screen Display)?

Visning pa skaermen [On-Screen Display
(OSD)] er en funktion pa alle Philips LCD
skeerme. Den szetter en slutbruger i stand

til at justere skaermindstillingerne, eller

veelge skeermens funktioner direkte via et
instruktionsvindue pa skeermen. Et brugervenligt
skeermvisningsinterface vises som nedenfor:

Model 237E3Q:

Model 237E3QPH:

1 (]
Power Sensor ‘Tl

In|
) nput
LS

Grundlzeggende og enkle anvisninger til
kontrolknapperne

| skeermmenuen ovenfor, kan du bruge

V A knapperne foran pa skermen til at flytte
markeren med, og tryk pa OK knappen, il at
bekrafte dit valg eller eendring.



OSD-menuen

Nedenstdende er en generel oversigt over
strukturen i OSD-displayet. Du kan anvende
den som opslag, nar du senere skal orientere
dig i de forskellige justeringer.

Main menu

— Power Sensor

— Input

— Picture

— Audio

— Color

|— Language

— OSD Settings

L— Setup

Sub menu

L

C
-

On — 0~4

Off

(available for selective models)

VGA

DVI (available for selective models)
HDMI 1 (available for selective models)

HDMI 2 (available for selective models)

Picture Format — Wide Screen, 4:3
Brightness — 0~100
Contrast — 0~100
SmartResponse  —— On, OFf (available for selective models)
SmartContrast — On, Off
Over Scan —— On, Off (available for selective models)
Mute — On, Off
Volume — On, Off
(available for selective models)
Color Temperature — 6500K, 9300K
sRGB
User Define Red: 0~100
Green: 0~100
Blue: 0~100

English . Espaiiol, Francais, Deutsch, Italiano,

Portugués, Pycckuit, 1A 3L, Tirkge

Horizontal — 0~100

Vertical — 0~100
Transparency — Off,1,2,3,4

OSD Time Out — 55, 10s, 20s, 30s, 60s
Auto

Power LED — 0,1,2,3,4
Pixel Orbiting — On, Off

H. Position — 0~100

V. Position — 0~100
Phase — 0~100
Clock — 0~100
Resolution Notification — On, Off
Reset — Yes, No

Information

El Meddelelse om oplesning

Denne skarm er fremstillet til optimal

ydelse pa dens native oplgsning, som er
1920x1080@60Hz. Nar skeermen bruger en
anden oplgsning, ses felgende advarsel pa
skeermen: Brug 1920x1080@60Hz for at opna
det bedste resultat.

Advarslen vedrgrende den naturlige oplasning
kan deaktiveres under Setup (Installation) i
OSD (skaermmenuen).

a Fysisk funktion
Vip




2.3 Fjern fod

a Fjern fod

Inden du begynder at adskille skeermens fod,
skal du felge vejledningerne nedenfor for at
undgd mulig beskadigelse eller personskade.

1. Anbring skeermen med forsiden vendt
nedad pa en javn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skeermen.

2. Fjern foden fra sgjlen, ved at:

(1) Bruge dine fingre til at lgsne skruen pa
bunden af foden.

(2) Treek langsomt foden op og ned for
at dbne lasen, der fastholder foden, og
treek langsomt foden af sgjlen.




3. Billedoptimering

3.1 Smartlmage Lite

El Hvad er dette?

Smartlmage Lite er forudindstillede indstillinger,
der optimerer skaermen i henhold til indholdet,
og som indstiller den dynamiske lysstyrke,
kontrast, farve og skarphed i realtid. Uanset om
du arbejder med tekstprogrammer; ser billeder
eller ser video, sa giver Philips Smartimage Lite
den optimale skaermydelse.

B Hvorfor behaver jeg det?

Du gnsker en skaerm, som giver det bedste
billede for alle typer indhold. For at @ge skaerm-
oplevelsen, indstiller Smartlmage Lite-softwaret
dynamisk lysstyrke, kontrast, farve og skarphed
i realtid.

El Hvordan virker det?

Smartimage Lite er en eksklusiv, farende
Philips-teknologi, som analyserer indholdet pa
skaeermen. Ud fra det valgte scenarie forbedrer
Smartimage Lite dynamiske billeders og
videoers kontrast, farvemaethed og skarphed for
at forbedre det viste billede - alt i realtid og blot
med et tryk pa en knap.

El Hvordan aktiveres Smartlmage Lite?

1. Tryk &p pa for at starte Smartlmage Lite
pa skaermen;

2. Tryk gentagende gange pa @D for at skifte
mellem Standard, Internet og Game (Spil).

3. Smartlmage Lite ses pa skeermen i fem

10

sekunder, men du kan ogsa trykke pa OK
for at bekreefte det.

4. Nar Smartimage Lite er aktiveret,
deaktiveres sRGB systemet automatisk.
For at bruge sRGB skal du deaktivere
Smartimage Lite med & foran pa
skaermen.

Udover at bruge B til at rulle ned med, kan

du ogsa trykke pa ¥ A for at vaelge og derefter
trykke pa OK for at bekrafte valget og derefter
igen lukke Smart-billede OSD.

Der kan velges mellem tre funktioner: Standard,
Internet, Game (Spil).

@ Smartlmage '

Standard

Internet

Game

e Standard: Forbedrer teksten og deemper
lysstyrken for, at @ge leesbarheden og
nedsatte anstrengelsen af gjnene.
Denne funktion gger leesbarheden og
produktiviteten, nar der arbejdes med
regneark, PDF filer; skannede artikler og
andre generelle kontorprogrammer.

* Internet: Denne funktion kombinerer
farvemaetheden, den dynamiske kontrast
og skarphed for at vise billeder og lignende
klart og i levende farver - alt uden synlige
fejl pa det skannet billede og blegnede
farver

*  Game (Spil): Aktivér overdrive-kredslgbet
for at fa den bedste reaktionstid,
reducere skeeve kanter pa genstande, der
bevager sig hurtigt pa skeermen, forbedre
kontrastforholdet mellem lyse og marke
omrader. Denne funktion giver brugeren
den bedste spilleoplevelse.



3.2 SmartContrast

Bl Hvad er dette?

Unik teknologi, der dynamisk analyserer det
viste indhold, og automatisk optimerer LCD
skaermens kontrastforhold til maksimal visuel
klarhed. Den gger baggrundsbelysningen og
giver et klarere, friskere og lysere billede eller
deemper baggrundsbelysningen med henblik
pa en tydelig visning af billeder pa en mark
baggrund.

B Hvorfor behaver jeg det?

Du gnsker den allerbedste visuelle klarhed
og visning pa enhvert indhold. Smart-kontrast
styrer den dynamiske kontrast og indstiller
baggrundslyset, sa det giver klare, friske og
lyse spil- og videobilleder, samt viser en
tydelig, laesbar tekst ved kontorarbejde.Ved at
nedsatte skeermens stremforbrug, sparer du
energiomkostninger og forlaenger skarmens
levetid.

El Hvordan virker det?

Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid, og farver og
baggrundslysets intensitet indstilles. Denne
funktion forbedrer den dynamiske kontrast og
giver sdledes en bedre underholdningsoplevelse,
nar du ser videoer eller spiller spil.

3.3 Philips SmartControl Lite

Det nye SmartControl Lite-software fra Phillips
giver dig mulighed for at kontrollere skaermen
via et nemt, grafisk interface. Komplicerede
justeringer hgrer fortiden til. Dette
brugervenlige software guider dig gennem
finindstilling af oplasning, kalibrering af farve,
justering af clockning/fase, RGB-hvidpunkt osv.

Dette igjefaldende, ikon-baseret software er
udstyret med den seneste teknologi i algoritmer
for hurtig behandling og reaktion, og er tilmed
Windows 7 kompatibel, og klar til at forbedre
din oplevelse med Philips-skaerme!

Kl installation

* Felg instruktionen og fuldfer installationen.

¢ Du kan starte, nar installationen er fuldfart.

*  Hvis du vil begynde senere, kan du klikke
pa genvejen pa skrivebordet eller pa
veerktgjslinjen.

PHILIPS www philips.com/welcome

Monitor driver and software installation

Sysem requiemencs:

- PC running Windovws . Vi, XP, 2000, 9.

Philps SmareControl
Sy spport snd requrement:

1. Sytam support Windows 7. Viss XP.

Opstartsguide

* Efter installation af SmartControl Lite
starter Wizard (guiden) automatisk, nar du
dbner programmet ferste gang.

*  Guiden leder dig trin for trin gennem
indstillingen af skaermen.

*  Du kan ogsa ga til Plug-in menuen, for at
starte guiden pa et senere tidspunkt.

* | Standard-vinduet kan du indstille flere
funktioner uden brug af guiden.

B smartcontrol 2

SmartControl Lite PHILIPS

Wizard

i

Adiust Ao

i

Color nput

o B2

=
Options Presets

A
R

—_
z

Help

Start Wzard



Bl Start med Standard-vinduet:

Adjust menu (Indstillingsmenu):
Med Adjust Menu (Indstillingsmenuen)
kan du indstille Brightness (Lysstyrken),

Contrast (Kontrast), Focus (Fokus), Position

(Position) og Resolution (Oplasning).

Udfer indstillingen ved at folge

Installationen kan annulleres med Cancel

instruktionerne.
(Annuller).
1 SmartControl
SmartControl Lite
Adiust \:)
Brightness.
Color 4 AR
rokon
Options
Resabton
Help
' smartControl

SmartControl Lite

]

Adjust
srghtness
\g Contrast
Color ~a
A
Y Foaus
22N
\g Postion
Optons %
Resolution

®

Help

PHILIPS

Brightness

Improperly adjusted Brightness wi result n a loss of
detai n darker mage areas. Adjust the Brightness for
the best possble picture qualty

. Lower the Brightness to the mnimum level.

2. Raise the Brightness to the desred level.

3. Adust the Brightness as needed to achieve
an equal separation of the stripes.

Brightness. 100

Undo Reset.

el

PHILIPS

Contrast

Adjust the Contrast (use the sider) to keep detais i
ghter image areas.
1. Raise the Contrast unti the numbers 1 and 2
are no longer visble.
2. Show he Contrast to make the
numbers 2 and 3 reappear. The number 1
should reman barely visble.

Contrast. 50

Undo Reset.

8 smartControl

SmartControl Lite

]

Adjust
Brightness
\g Contrast
Cobx A
>

- Focus
=

\g Poseion

options
Resoluton

®

Help

W smartcontrol

SmartControl Lite

Adjust
enghness
\g Contrest
Color ~A
A
- Focus
Q. :!
\ Postion
Options %
? Resolton
Help
8 smartcontol

SmartControl Lite

]

Adiust
Brightness
\g Contrast
Color A
A
" Focus
AN
\E Postion
Options
Resolution

&

Help

@

PHILIPS

Focus

Your display's tming needs to be synchronized with
the video signal

Pitch: Try to
Phase: Adjust t¢
movement on

ch s0
o &
phase 7
Undo Auto Setup
Zx
PHILIPS
Position

the image on

Use the Position bu enter tf
this tool, you can postion the image

your dsplay. Using this
up, down, left, or right.

Use the Up/Down buttons to center the image
vertialy.

Use the Left/Right buttons to center the image
horzontaly.

Undo Reset.

PHILIPS

Resolution

Preferred resolution. For your
, clear text, cokrs, and images,
Id be set to its Preferred resoltion

You are curren
diply to shol
Your display st

I your display s at a Non-Preferred resolution, click
on the Preferred button to change your resolution to
I Enable Resolution Notier

Picture Format
I 43 3sectatio

L




Color menu (Farvemenu):

‘SmartControl X
@

SmartControl Lite

Med Color Menu (Farvemenuen) kan du
indstille RGB, Black Level (Sortniveau),
White Point (Hvidpunkt), Color Calibration
(farvekalibrering) og Smartimage Lite (se
afsnittet Smartlmage Lite).

Udfer indstillingen ved at folge
instruktionerne.

Se nedenstdende oversigt med
undermenupunkter baseret pa din
indtastning.

Eksempel pa Color Calibration
(farvekalibrering):

PHILIPS

Black Level

result in 2 loss of
he Black Level for

Improperly adjusted Black Level

detai n darker image areas. Ad

the best possble picture qualy.

1. Adjust the biack level of the Red, Green, and
Blug usng the sider bars.

i

Adjust ReB
it

White Pont.

Display Gamma = .’

-
Options Calibration
ap

Smartimage

Eg Green 50
Color =
s~

Undo Reset.

&

Help

W smartcontol

SmartControl Lite

Adjust R68
Back Level
Color Whte Pont

Display Gamma
L

Optons Glbration

ap

Smartimage

&€

Help

PHILIPS

White Point

it at which equal combinations
d blue ight at ful ntensity reate

colors cick the Reset button then

1. Please select the White Point vakie for the best
possble color qualty.

Whte Point 6500K
= - L)

Undo Reset.

13

B Smartcontrol

SmartControl Lite

]

Adiust RGB.
Black Level
White Point

Dsply Gamma
LN

Options calbraton

ap

Smartimage

g gﬁ

®

Help

W smartcontrol

SmartControl Lite

]

Adjust Res
Black Lavel

‘.‘.’mte/Pumt
Displey Gamma
!
>
Options. Calbration
ap

Smartimage

"E gﬁ

®

Help

DX
PHILIPS

Display Gamma
Gamma i 3 component of the pvel brightness n 3
dsoly. A lower Gamma vake produces brghter piels
3nc 3 higher Gamma vake procuces darker pxes. The
detauk vloe for Gamma 2.2

To adjust Gamma, Smartimage must be s to OF.
Click the SmartImage Off button before adjusting
Gamma.

1. Use the sider to select the desred Gamma.

Display Gamma 22

Undo Reset

=]
(x

PHILIPS

Calibration

Your display needs to
for t to produce the

justments to mage qualty or
whenever you move your dispiay to a new locatin.
1. Make al other necessary adjustments to mage
qualey frst
2. Press Show Me to leam how to use the
calibration tooks
3. Fraly, press Start to begh the calibration

process

albration
e designed n colaboration with Joseph

nes.
Protected by U.S. Patent No. 6,686,953

Show Me start

Quick View

“Show Me” (Vis Mig) starter vejledningen til
farvekalibrering.

Start — starter en 6-trins
farvekalibreringssekvens.

Quick View (Hurtigvisning) indleser fer/
efter-billederne.

For at vende tilbage til Color (Farve)
vinduet, skal du klikke pa Cancel (Annuller).

Enable color calibration (Aktiver
farvekalibrering) - der som standard er
aktiveret. Hvis markeringen er fiernet, kan
du ikke udfere en farvekalibrering, ligesom
start- og quick-visning knapperne er
gratonede.

Der skal veere patentoplysninger pa
kalibreringsskaermen.



Forste farvekalibreringsskaerm:

*  Previous (Foregaende) knappen er
deaktiveret, indtil du gar videre til den
anden farveskaerm.

*  Next (Neste) gar til efterfalgende mal
(seks mal).

»  (Ga til sidst til File > Presets (File > Forvalg)
vinduet.

»  Cancel (Annuller) lukker Ul og vender
tilbage til plug in siden.

Smartlmage Lite

Smart-Billede - tillader brugeren at &ndre
indstillingerne, for at opna en bedre
skaermindstilling baseret pa indholdet.

Nadr der indstilles pa Entertainment
(Underholdning), aktiveres Smart-Kontrast og
Smart-Svar.

8 smartcontrol @’

SmartControl Lite PHILIPS

SmartImage

Options > Preferences (Funktioner >
Indstillinger) - er kun aktiv, nar Preferences
(Indstillinger) er valgt i Preferences (Funktioner)-
rullemenuen. Pa en ikke-understattet skeerm
med DDC/CI er kun Help (Hjalp) og Options
(Funktioner) til radighed.

14

8 smartControl 2%

SmartControl Lite PHILIPS

\d mﬁms

Adjust o

\g Auto Piot
-

Color Input

e
@ Py
2
Optons 5

Viser nuveerende, foretrukne indstillinger.

Funktionen aktiveres ved at afmaerke feltet.
Afmerkningsfeltet er en flip-flop.

Enable Context (Aktiver Indhold) menuen er
som standard afmaerket (Til) pa skrivebordet.
Menuen Enable Context (Aktivér kontekst)
viser valgmulighederne i SmartControl Lite
pa Select Preset (Velg Forvalg) og Tune
Display (Indstil Display) i genvejmenuen

ved at hgjreklikke pa skrivebordet. Disabled
(Deaktiveret) fierner SmartControl Lite fra
genvejsmenuen.

Enable Task Tray (Aktiver Jobbakke)

menuen er som standard afmaerket (Til)

pa skrivebordet. Menuen Enable Context
(Aktiver Indhold) ger; at systembakkens ikon
til SmartControl Lite vises. Et hgjreklik pd
jobbakke-ikonen viser menufunktionerne

for Help (Hjelp), Technical Support (Teknisk
Support), Check for Upgrade (Tjek efter
opgraderinger), About (Om) og Exit (Afslut).
Nar Enable Task Tray (Aktiver Jobbakke)
menuen er deaktiveret, viser jobbakke-ikonen
kun EXIT (AFSLUT).

Run at Startup (Ker ved opstart) er

som standard afmaerket (Til). Nar den

er deaktiveret, starter SmartControl Lite

ikke ved opstart og ikonet vises ikke i
systembakken. SmartControl Lite kan kun
startes fra genvejen pa skrivebordet eller fra
programfilen. Intet forvalg, som er indstillet til
at kere ved opstart, indleeses nar denne boks
ikke er afmarket (er deaktiveret).

Enable transparency mode (Aktivér
gennemsigtighedstilstand) (Windows 7, Vista,
XP). Standard er 0% uigennemsigtighed.



Options > Input (Funktioner > Indgang) -
kun aktiv, ndr Input (Indgang) er valgt i Options

(Funktioner) rullemenuen. Pd en ikke-understettet

skeerm med DDC/Cl er kun Help (Hjaelp) og
Options (Funktioner) til radighed. Alle andre

faneblade i SmartControl Lite er ikke til radighed.

8 smartcontrol

SmartControl Lite

i

Adiust Audio

\% Auto Piot.
Color Tnput
ot B
2
Options Presets
-

Help

PHILIPS

Input

our dsla s o s (connectons on back of
this display) s0 you can hook up two different sources
at the me tme. Use the Analog In and Digital Tn
buttons t
are currentl

lect which source you'd lke to view. You
jeving the [

y have to
ofyour mantr to Swieh back
before SartContolfunctonaly can be restor

Analog In Digial In

* Vis Source (Kilde) instruktionsvinduet og
nuveerende indgangskildeindstillinger:
* P& enkeltindgangsskeerme ses dette vindue

ikke.

Options > Audio (Funktioner > Lyd) - er
kun aktiv, nar Audio (Lyd) er valgt i Options
(Funktioner) rullemenuen.

P& en ikke-understgttet skeerm med DDC/CI

er kun Help (Hjaelp) og Options (Funktioner) til

radighed.
8 smartcontrol

SmartControl Lite

i

Adiust -4

Auto Pivot

§

ot
B
wed

a4

>
Options Presets

® ”@ Q

Help

Muti Monitors

PHILIPS

Audio

Adjust the Volume of the integrated loudspeakers by
usng the sider.

Tum off the integrated loudspeakers by checking the
Mute checkbox.

I mute

Volume 100

Undo
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Help > User Manual (Hjelp >
Brugervejledning) - er kun aktiv, nar User
Manual (Brugervejledning) er valgt i Help
(Hjeelp) rullemenuen. Pa en ikke-understattet
skeerm med DDC/CI er kun Help (Hjeelp) og
Options (Funktioner) til radighed.

8 smartControl

SmartControl Lite

1]

Adjust
User Manual
a
(]
Update
Color
N Display 1D
AZN
L[g System ID
Options M
Version

8

Help

2
PHILIPS
User Manual
I you ne setting up or operating SmartControl,

clck th ort button. You'l have the

h Suppor
option to fil out an Assstance Form.

You can akso choose to have information about your
ttach e assstance

User Manual Tech. Support

Help > Version (Hjelp > Version) - er kun aktiv,
narVersion (Version) er valgt i Help (Hjeelp)
rullemenuen. Pa en ikke-understattet skaerm
med DDC/Cl er kun Help (Hjeelp) og Options

(Funktioner) til radighed.

8 smartconrol

SmartControl Lite

]

Adjust

I

Color

€

Options

)

Help

UserManul
P
®
Update

-

Display ID
System ID

%5

Verson

PHILIPS

Version

SmartCon

versan 0 100 EVALUATION dtune pp-R2009-12-17-
130

DDC/CI Communication: Yes - ATI2 APT

Copyright © 1993-2009 Portrait Dispays, Inc.



Context Sensitive (Indholdssensitiv) menu

Context Sensitive (Indholdssensitiv) menuen
er som standard aktiveret. Hvis Enable Context
(Aktiver Indholdssensitiv) menuen er afmaerket
i Options > Preferences (Funktioner >
Indstillinger) vinduet, ses menuen.

@ SmartControl
Select Preset L4
Tune Display

Context Menu (Context menuen) har fire

punkter:

*  SmartControl Lite - ndr valgt, ses About
(Om) skeermen.

* Select Preset (Valg Forvalgt) — herefter
vises en hierakisk menu med gemte forvalg,
der straks kan bruges. En afkrydsning viser
det nuvaerende valgte forvalg. Factory
Preset (Fabriksforvalg) kan ogsa hentes i
rullemenuen.

» Tune Display (Indstil Skeerm) - dbner
kontrolpanelet til SmartControl Lite.

*  Smartlmage Lite - Kontroller nuvaerende
indstillinger, Standard, Internet, Game (Spil).

Task Tray (Jobbakke) menu aktiveret
Menuen i systembakken kan ses ved at
hgjreklikke pa SmartControl Lite-ikonet
i systembakken. Et venstreklik starter
programmet.

Help

Technical Support
Check for Update
About

Exit

Jobbakken har fem punkter:

*  Help (Hjeelp) - adgang til User Manual
file (brugervejledningsfilen): Abner User
Manual (Brugervejledningen) med standard
browservinduet.

* Technical Support (Teknisk Support) - viser
siden med teknisk support.

*  Check for Update (Tjek for opdateringer)

- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den nyeste
version.

* About (Om) - viser detaljerede
referenceoplysninger: Produktversion,
udgivelsesinformation og produktnavn.

*  Exit (Afslut) - Luk SmartControl Lite.

Huvis du vil kere SmartControl Lite igen, skal
du enten valge SmartControl Lite i Program
menu (programmenuen), dobbeltklikke pa
skrivebordet eller genstarte systemet.

PHILIPS

SmartControl

‘SmartControl
‘Version 3.20
dltune-standard-R2007-01-04-1151-23
Copyright 1993-2007 Portrait Displaye, Inc.
Patents Pending

Task Tray (Jobbakke) menu deaktiveret
NarTask Tray (Jobbakke) er deaktiveret i
indstillinger-mappen, er kun EXIT (AFSLUT)
valgmuligheden til radighed. Hvis du helt vil
fierne SmartControl Lite fra systembakken,

skal du deaktivere Run at Startup (Ker ved
opstart) i Options > Preferences (Muligheder >
Indstillinger).



4. PowerSensor™

(Kun pa 247E3LPH modellen)

PowerSensor er en unik miljgvenlig teknologi fra Philips, som giver brugeren mulighed for at spare

op til 80% af stremforbruget. Ligesom Philips Sense og Simplicity Promise, virker denne brugervenlig
teknologi uden at det er ngdvendigt at installere hardware eller software, og uden at brugeren skal gere
noget i standardtilstanden.

Kl Hvordan virker det?
*  PowerSensor udsender og modtager harmlgse “infrargde” signaler; sa den kan finde brugerens
tilstedeveerelse.

* Nar brugeren er foran skaermen, bruges de indstillinger, som brugeren selv har sat, f.eks. lysstyrken,
kontrasten, farver osv.

* Antages det for eksempel, at skeermen var sat til 100% i lysstyrke, og brugeren forlader hans/
hendes saede og ikke leengere sidder foran computeren, sa reducere skaeermen automatisk
stremforbruget til 80%.

Bruger sidder foran skermen Bruger ikke til stede

Stremforbruget, som er vist ovenfor; er udelukkende til reference.

2] Indstilling

Standard indstillinger

Pa standardindstillingen (indstilling 3), er PowerSensor fremstillet til at finde tilstedeveerelsen af en
bruger, hvis han/hun er mellem 90cm og 110 cm (35,4 og 43,3 tommer) fra skaermen, og indenfor 5
grader til venstre eller hgjre fra skeermen.

Brugerdefinerede indstillinger

* Huvis du ensker at veere et sted udenfor det ovennaevnte omradet, skal du vaelge en hgjere
signalstyrke, for at opna en optimal detekteringseffekt: Jo hgjere indstillingen er sat til, jo steerkere
er detekteringssignalet. For at opna en maksimal effektivitet og ordentlig detektering med
PowerSensor, bedes du sidde direkte foran skaermen.

* Hvis du veelger at sidde mere 110 cm eller 43,3 tommer vaek fra skaermen, skal du bruge det
maksimale detekteringssignal, som har en afstand pa op til 130 cm eller 51,2 tommer: (indstilling 4)

*  Da merkt tgj her en tendens til at absorbere infrarade signaler; selv hvis brugeren sidder indenfor 100
cm eller 40 tommer af skeermen, bedes du skrue op for signalstyrken, hvis du har sort eller merkt tgj pa.

17



* Du kan altid vende tilbage til standardindstillingen (indstilling 3)

Genvejstast Sensor-afstand

powersensor | = [ILLELENIERENNNNE +3

/v ©fa SENSOR/ 4 /oK »

-_—

E sadan justere du indstillingerne

Hvis PowerSensor ikke virker ordentligt indenfor eller udenfor standardomradet, finindstiller du
detekteringen pa folgende made:
* Tryk pa PowerSensor-genvejstasten.

* Herefter kan du se standardindstillingen ‘3’ pa justeringsbjeelken.
*  Stil PowerSensor-detekteringen pa 4 og tryk pa OK.
» Test den nye opsatning, for at se om PowerSensor finder dig ordentligt i din nuvaerende placering.

& Bemerk

En manuelt indstillet PowerSensor vil forblive i drift, medmindre eller indtil den genindstilles, eller hvis
den justeres tilbage til standardindstillingerne. Hvis du synes at PowerSensor er alt for falsom overfor
neerliggende bevagelser, skal du justere til en lavere signalstyrke.
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5. Tekniske specifikationer

Skeermpaneltype IPS

Baggrundslys LED

Panelstarrelse 23"W (58,42 cm)
Billedforhold 16:9

Pixel pitch 0,265 x 0,265 mm
Lysstyrke 250 cd/m?
Smart-kontrast 20,000,000:1
Kontrastforhold (typ.) 1000:1
Reaktionstid (norm.) 14 ms

Smart-Svar 7 ms

Optimal oplgsning 1920x1080@60Hz
Synsvinkel 178° (H) /178° (V) @ C/R > 10
Billedforbedring Smartimage Lite
Skeermfarver 16,7 M

Vertikal opdateringshastighed 56Hz - 76Hz
Horisontal frekvens 30kHz - 83kHz
sRGB JA

DVI (digital, tilgeengelig til model 237E3Q),VGA (Analog),

Inputsignal HDMI (tilgzengelig til model 237E3QPH)
Inputsignal Separat synk., synk. pa gren

. 237E3Q: /v ©/A 0/« /0K 0
BT e 237E3QPH: &/v ©/A SENSOR /< /0K 0]
OSD sprog Engelsk, fransk, tysk, spansk, italiensk, russisk,

simplificeret kinesisk, portugisisk og tyrkisk

Andre funktioner

Kensington-Ias

"Plug & Play" kompatibilitet

Vip

DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

-5/+20

237E3Q:

(EnergyStar 5.0 testmetode)

5VAC, 50Hz +/- 3Hz

Teendt-tilstand (typ.) 32,7W(typ.)
. AC indgangsspaending | AC indgangsspending | AC indgangsspaending
Energfiorbrug ved 100VAC +/- ved 115VAC +/- ved 230VAC +/-

5VAC, 60Hz +/- 3Hz

5VAC, 50Hz +/ -3Hz

Normal funktion (typ.)

27,13W

2696W

26,/1W

Sovetilstand

0,5W

05W

0,5W

Fra

0,5W

0,5W

0,5W
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AC indgangsspaending

AC indgangsspaending

AC indgangsspaending

Varmetab* ved 100VAC +/- ved 115VAC +/- ved 230VAC +/-
5VAC,50Hz +/- 3Hz | 5VAC,60Hz +/- 3Hz | 5VAC,50Hz +/-3Hz

Normal drift 92,59 BTU/hr 92,01 BTU/hr 91,16 BTU/hr

Sovetilstand 1,71 BTU/ 1,71 BTU/ 1,71 BTU/

Fra 1,706 BTU/ 1,706 BTU/t 1,706 BTU/

Strgmdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)

Stremforsyning

Indbygget, 100-240V AC, 50-60 Hz

237E3QPH:
[swom ]
Teendt-tilstand (typ.) 32,7W(typ.)
. AC indgangsspanding | AC indgangsspanding | AC indgangsspaending
(ngerfg;’grf 0 testmetode) ved 100VAC +/- ved 115VAC +/- ved 230VAC +/-
5VAC, 50Hz +/- 3Hz | 5VAC,60Hz +/- 3Hz | 5VAC,50Hz +/ -3Hz
Normal funktion (typ.) 26,30W 26,28W 26,78W
Sovetilstand 0,5W 0,5W 0,5W
Fra 03W 03W 03W
AC indgangsspaending | AC indgangsspaending | AC indgangsspaending
Varmetab* ved 100VAC +/- ved 115VAC +/- ved 230VAC +/-
5VAC, 50Hz +/- 3Hz | 5VAC,60Hz +/- 3Hz | 5VAC,50Hz +/ -3Hz
Normal drift 89,76 BTU/hr 89,69 BTU/hr 91,4 BTU/hr
Sovetilstand 1,71 BTUA 1,71 BTUA 1,71 BTUA
Fra 1,02 BTU/ 1,02 BTU/t 1,02 BTU/
Strgmdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)

Stremforsyning

Indbygget, 100-240V AC, 50-60 Hz

Produkt uden fod (B x H x D)

568 x 435 x 238 mm

Produkt uden fod (B x H x D)

568 x 345 x 46 mm

Produkt med fod 346 kg
Produkt uden fod 2,93 kg
Produkt med emballage 5,28 kg

Temperaturomrade (drift) 0°C til 40°C

Temperaturomrade o . o

(ikkepi it -20°C til 60°C

Relativ fugtighed 20% til 80%

el Betjenihg: + 3.658 m (12.000 fod)
Ikke drift: + 12192 cm (40.000 fod)

MTBF 30.000 timer




ROHS JA

EnergyStar 50

EPEAT Silver (www.epeat.net)
Emballage 100 % genbrugelig

CB, CCC, CECPR EPA, GOST, 1SO9241-307, KUCAS, PSB,

Myndighedernes godkendelser SASO, SEMKO, UL

Farve Sort (Bag), Sort med bla nuance (Front)
Finish Blank
S Bemark

1. EPEAT Gold og Silver er kun gyldig hvor Philips registrer produktet. Besgg venligst www.epeat.net
for registreringsstatus i dit land.

N

Disse data kan endres uden varsel. Ga til www.philips.com/support for at hente den seneste
version af brochuren.




5.1 Oplesning og forudindstillede
funktioner

El Maksimal oplesning
1920x1080@60Hz (analogt indgang)
1920x1080@60Hz (digital indgang)

B Anbefalet oplesning
1920x1080@60Hz (digital indgang)

31,47 720x400 70,09
31,47 640x480 59,94
35,00 640x480 66,67
37,86 640x480 72,81
37,50 640x480 75,00
37,88 800x600 60,32
46,88 800x600 75,00
48,36 1024x768 60,00
60,02 1024x768 7503
63,89 1280x1024 60,02
79,98 1280x1024 75,03
55,94 1440x900 59,89
70,64 1440x900 74,98
65,29 1680x1050 59,95
67,50 1920x1080 60,00
& Bemark

Bemaerk venligst at din skaerm virker bedst med
native oplgsning pa 1920x1080@60Hz. For

at opna den bedste skeermkvalitet, bedes du
venligst bruge denne oplasning.
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6. Stromstyring

Hvis der er installeret et skaermkort eller
software pa pc'en, der er i overensstemmelse
med VESA DPM, kan skeermen automatisk
nedsatte stremforbruget, nar den ikke bruges.
Nar input fra tastatur, mus eller anden input-
enhed registreres, "vagner" skaeermen automatisk
igen. Nedenstdende tabel viser denne
automatiske energisparefunktions stremforbrug
og signalering:

237E3Q:

VESA tilstand | Video | V synk | L synk [ Opbrugt strem | LED Farve

Adv | TL | e | Je | 266Wp) | Huid
Sovetilstand | FRA | Nej | Nej | 05W (op) (bm:r)
Kontakt Fra | FRA - - 0,5W (typ.) FRA

237E3QPH:

VESA tilstand| Video |V synk | L synk [ Opbrugt strem | LED Farve

Aktiv TIL Ja Ja 26,6W(typ.), Hvid

. . ’ Hvid
Sovetilstand | FRA | Nej Nej 05W (typ.) (blinker)

Kontakt Fra | FRA - - 03 W (typ.) FRA

Felgende opsatning bruges til at male
skaermens strgmforbrug.

* Indbygget oplasning: 1920x1080
*  Kontrast: 50%
*  Lysstyrke: 250 nits

* Farvetemperatur: 6500k med fuldt, hvidt
manster

@ Bemaerk
Disse data kan andres uden varsel.
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7. Lovmaessige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the

planet

carries the TCO Certified label.
This ensures that your display is

designed, manufactured and tested according to

some of the strictest quality and environmental

requirements in the world. This makes for a high

performance product, designed with the user

in focus that also minimizes the impact on the

climate and our natural environment.

The display you have just purchased

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.
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*  Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

* Very low energy consumption both in on-
and standby mode minimize climate impact.

e Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

*  Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is now
requested by users and IT-manufacturers all
over the world. About 50% of all displays world-
wide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document, Ver. 2.1

I[n Technology for you and the planet
CERTIFIED



EPEAT

(www.epeat.net)

X, The EPEAT (Electronic
Q@ Product Environmental
& Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

* EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

»  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

»  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

»  EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

* 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

»  2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

»  GS EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-Il (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

» TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR”
guidelines for energy efficiency.

i)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.

26

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

“This davice belongs to catagory B devices a8 described in EN 55022, unless it is spaci-
cally stated that it i a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up 1o 30 metars). The user of the
davice is obligad to take all staps necessary o remove sources of interfarance to tals-
communication or other devicas.

Pokd neni na fypovém &tk potstase uvedena, # spedé do do tidy A podie EN 55022,
spada automaticky do tfidy B podle EN 55022, Pro zafizen! zafazend do tFidy A (chranné
pésma 30m) podie EN 5502 platl nésleduficl. Dojde-li k rullan! telskomunikatich nebo
finjich zafizani e uivatal povinnen provést takova opatfgni, atry nen odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1T-42107
and PN-89/E-06251.

Wymagania Polskiege Centrum Badan i Certyfikacji
Uzpedzenie powiano byt rasilane z paiasds 2 preylaceonym obwodem ochronmym (gnisedo
katkiem). Wapdipracuiaee 2 soby ufzadzenia (Komputer, monitor, drukarka) powinty bye msilane
& togo samego dridla
Instalacja elektrycna pomiesaczenia powinna mwie
przs zwarciami, w postaci bezpieconika o warke
W el catkowitogo wybyerenia urspdzents 2 siect zasilania, nalezy wyint wiycekg kabla
easilajacega = poazdka, kidre powinno ssidowad s w pobliz urmJJanm:I!\t Batwi dosiepne.
Znak bespieczefsrwa "B” potwierdzs 2podnosé uresdzenia » wymaganiami bezpiecsefaiwa
whytkowania awartymi w PN-93T-42107 | PN-§9E-D6;

w przeworksie fzowym rezecrowa achrang
marmienavwe] e wicksej ni 164 (amperiuw).

Pozostale instrukcje bezpieczensiwa

* Niemaledy urywad wiyceek sdapterowych lub usuwaé kolka abwedu ackrornego 2 wiyeeki.
Jekeli Lu\m‘WIILJLJ LRy |:|1:\:\Jlural‘ra o naledy whyd preediuzace 3-pylowego 2
System kmpalerowy rnlny sabezpivcryt prred nagtymi, chwilow
ac eliminatora preepied, urradrenia dopasow
berzakidceniowe irinia zasilania.

tic nie leZalo na kablach systemu kompuierowego, arz aby kable nie
dzse tokna byloby na sie nadeptywad lub poryksd sig o nie.

warostami lub spad-
X

T e p——

Nie maleiy wpychad adnych preedmiotion do atwost sy
podar lub porpenie pridem, poprzez o

najdowad sig 2 dala od g

Tacyjnych. Nakezy un

karmpuler oriz umisszezanss kamputera w ciasmym migse bez mailiwobe eyrkalac peoi-
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTAVERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RBAZEARERZIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Réntgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erflillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhéhte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betragt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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8. Kundeservice og garanti

8.1 Philips' regler ved pixeldefekter
pa fladskaerme

Philips tilstreeber at levere produkter af den
hgjeste kvalitet.Vi anvender nogle af branchens
mest avancerede produktionsprocesser og
udferer en streng kvalitetskontrol. En gang
imellem er defekte pixler eller sub-pixler pa
TFT-skeerme dog uundgaelige. Ingen producent
kan garantere, at alle paneler vil veere fri for
pixeldefekter, men Philips garanterer, at enhver
skeerm med et uacceptabelt antal defekter
repareres eller udskiftes under garantien.

Dette notat forklarer de forskellige former

for pixeldefekter og definerer de acceptable
defektniveauer for hver type. For at veere
berettiget til reparation eller udskiftning under
garantien skal antallet af pixeldefekter pa en TFT
-skaerm overskride disse acceptable niveauer.
For eksempel ma hgjst 0,0004% af sub-pixlerne
pa en skeerm vare defekte. Desuden seetter
Philips endnu hgjere kvalitetsnormer pa visse
typer eller kombinationer af pixeldefekter, der er
mere generende end andre. Denne pixelpolitik
geelder i hele verden.

sub-pixler

RGBW

pixler

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af
tre sub-pixler med primaerfarverne red, gren og
bla. Nar mange pixler sattes sammen, kan de
danne et billede. Nar alle sub-pixler i en pixel
lyser; fremstar de farvede sub-pixler tilsammen
som enkelt hvid pixel. Hvis de alle er morke,
fremstar de tre farvede sub-pixler tilsammen
som en enkelt sort pixel. Andre kombinationer
af oplyste og merke sub-pixler fremstar som
enkelte pixler i andre farver.

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optraeder pa
skaermen pa forskellige mader. Der er to
kategorier af pixeldefekter og flere typer sub-
pixeldefekter i hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels
eller underpixels, der altid lyser eller er “teendt’.
Det vil sige, at en lys prik er en underpixel, der
fremstar pa skeermbilledet, nar skeermen viser et
mearkt menster. Der er fglgende typer defekte
lyse prikker.

En teendt red, gren eller bla sub-pixel.

l ¢

To sammenliggende tendte sub-pixler:
- Red + Bla = Lilla

- Red + Grgn = Gul

- Gren + Bla = Cyan (Lysebla)

Tre sammenliggende teendte pixler (en hvid
pixel).
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@ Bemaerk

En red eller bld lys prik skal veere mere end 50
procent lysere end de omkringliggende prikker,
mens en gron lys prik er 30 procent lysere end
de omkringliggende prikker.

Defekte morke prikker

Defekte merke prikker fremkommer som
pixels eller underpixels, der altid er merke
eller er“slukkede”. Det vil sige, at en lys prik er
en underpixel, der fremstar pa skaermbilledet,
nar skaermen viser et mgrkt menster. Der er
folgende typer defekte marke prikker.

Tatsiddende pixeldefekter

Da pixel- og sub-pixeldefekter af samme
type, der ligger teet pa hinanden, kan veere
mere igjnefaldende, specificerer Philips ogsa
tolerancer for teetsiddende pixeldefekter.

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal en TFT-skaerm i en Philips
fladskaerm have pixel- eller sub-pixeldefekter,
der overskrider de tolerancer, der er gengivet i
folgende tabeller.

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU
1 teendt sub-pixel 3

2 sammenliggende taendte sub-pixler 1

Tre sammenliggende taendte sub-pixler (en hvid pixel) 0

Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU
1 merk sub-pixel 5 eller ferre

2 sammenliggende marke sub-pixler 2 eller ferre

3 sammenliggende marke sub-pixler 0

Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller feerre
SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU
Samlede bright- eller black dot-defekter af alle typer 5 eller ferre

@ Bemaerk
1.
2.

1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
Denne monitor er i overensstemmelse med 1SO09241-307 (1ISO9241-307: Testmetoder for

ergonimiske kray, analyse og overensstemmelse pa elektroniske visuelle skaerme)
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8.2 Kundeservice og garanti

For oplysninger om garantidaekning og gzeldende stgttekrav i dit omrdde, bedes du besagge www.
philips.com/support website for details. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via
nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

Land ASC Kundeservice tIf Pris

Germany Siemens 1&S +49 01803 386 853 €009

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010

Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €008
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens &S +43 0810 000206 €007

Belgium E Care +32 078 250851 €006
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktoplysninger til CENTRAL- OG @STEUROPA:
Land Callcenter ASC

Kundeservice tif

Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV” Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
ile;:i;r%egro NA Kim Tec d.o.o. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
U NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
R— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware . +36 12426331
NA Profi Service +36 1 814 8080

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter
Brazil

- Vermont
Argentina

Kundeservice tif
0800-7254101

0800 3330 856

Kontaktoplysninger til Kina:
Kina
Kundeservice tlf: 4008 800 008

Kontaktoplysninger tiil NORDAMERIKA:

Land Callcenter N e Kundeservice tlf
USA. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696




Kontaktoplysninger til APMEA:

Land

Callcenter

ASC

Kundeservice tif

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand [ NA Visual Group Ltd. 0800 657447
Hong Kong / : Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. | 1. -\ Tel (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 1o 56677
. , . . . Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
South Korea | NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
United Arab 5 AL SHAHD COMPUTER LLL.C |00971 4 2276525
Emirates
Israel NA Eastronics LTD 1-800-567000
FPT Service Informati +84 8 38248007 Ho Chi Minh City
Vietnam NA Com va Cft g Ormatic +84 5113.562666 Danang City
By R +84 5113562666 Can tho Province
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d.IS'tI”IbUtOI" and/or service
provider currently
Bangladesh NA Distributor: Computer Source | 880-2-9141747,9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty [ 855-023-999992

buy-out)
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9. Fejlfinding og FAQ

9.1 Fejlfinding

Denne side omhandler problemer, som kan
klares af brugeren selv. Hvis problemet stadig er
der; efter at du har prevet disse lasninger, skal
du kontakte Philips' kundeservice.

a Almindelige problemer

Intet billede (stremdiode lyser ikke)

* Kontroller, at ledningen er sat i
stikkontakten og bag pa skaermen.

* Kontroller forst, at stremkontakten foran
pa skeermen er i OFF (FRA), og stil den
derefter pa ON (TIL).

Intet billede (stremdiode lyser hvid)
»  Kontroller, at der er teendt for computeren.

* Kontroller, at signalkablet er korrekt
forbundet til computeren.

* Kontroller, at der ikke er nogen bgjede
stikben pa signalkablets stik. Hvis der er det,
skal du fa kablet repareret eller udskiftet.

*  Energy Saving (Energisparefunktionen) kan
vare aktiveret

Skaerm siger

Attention

Check cable connection

* Kontroller, at signalkablet er korrekt
forbundet til computeren. (Se ogsa Quick
Start Guiden).

*  Tjek, om skeermkablets stikben er bgjede.

*  Kontroller, at der er teendt for computeren.

AUTO (AUTOM.) knappen virker ikke

*  Den automatiske funktion fungerer kun i
VGA-Analog (VGA analog)-tilstand. Hvis
resultatet ikke er tilfredsstillende, kan der
foretages manuelle justeringer via OSD-
menuen.

& Bemark
Den automatiske funktion er ikke ngdvendig i
DVI-Digital (DVI digital)-tilstand.

Synlige tegn pa rog eller gnister

*  Forsgg ikke selv at fejlfinde

*  Treek straks skeermens stik ud af
stikkontakten

»  Kontakt straks en repreesentant fra Philips
kundeafdeling.

H Billedproblemer

Billedet er ikke centreret

* Justér billedets position med funktionen
“Auto” (Automatisk) i OSD Main Controls
(OSD-menuerne).

* Juster billedpositionen med Phase/Clock
(Fase/Klokke) i Setup (Opsatning) i OSD
Main Controls (OSD hovedmenuen). Den
kan kun bruges i VGA mode (VGA-tilstand).

Billede vibrerer pa skermen
* Tjek at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

-
=
=
=

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD Main Controls (OSD-
menuerne).

*  Eliminer de lodrette bjelker med Phase/
Clock (Fase/Klokke) i Setup (Opseetning) i
OSD Main Controls (OSD hovedmenuen).
Den kan kun bruges i VGA mode (VGA-
tilstand).

Vandret flimren

e Justér billedet med funktionen “Auto”
(Automatisk) i OSD Main Controls (OSD-
menuerne).




*  Eliminer de lodrette bjeelker med Phase/
Clock (Fase/Klokke) i Setup (Opsatning) i
OSD Main Controls (OSD hovedmenuen).
Den kan kun bruges i VGA mode (VGA-
tilstand).

Billedet er slgret, uklart eller for merkt
* Indstil kontrasten og lysstyrken i OSD.

Der forbliver et “efterbillede”,
“brandmarkerne” eller “spogelsesbillede”,
efter at der er slukket for stremmen.

»  Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage “brandmeerker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pd skaermen.
“Breendmaeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt feenomen
i LCD skaermteknologi. | de fleste tilfeelde vil
“brandmaerkerne” eller “efterbilledet” eller
“spogelsesbilledet” forsvinde gradvist, efter
skaermen er blevet slukket.

* Serg altid for at aktivere en pauseskerm,
der beveeger sig, nar skeermen efterlades
uden at blive anvendt.

*  Du skal altid bruge en pauseskaerm eller
et andet program, der opdaterer skeermen
regelmeessigt, hvis LCD skaermen viser
statisk materiale i leengere perioder.

* Alvorlig “brandmaerkerne’- eller
“efterbillede”- eller "spagelsesbillede’-
symptomer forsvinder ikke og kan ikke
repareres. Ovennavnte skader er ikke
daekket af garantien.

Billedet er forvraenget. Tekst er utydelig eller

sloret.

* Indstil pc’ens skeermopl@sning som
skaermens anbefalede, native opl@sning.

Der ses rgde, bld, merke og hvide pletter pa

skaermen

* De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag.
Se politikken om pixels for yderligere
oplysninger.

36

“Teendt” lyset er for kraftigt, og det er

forstyrrende

*  Du kan justere “Teendt” lyset med
Strgmdiode i OSD main Controls (OSD-
menuerne).

For yderligere hjalp, se venligst listen over
Forbrugerinformationscentre og kontakt
Philips's Kundeservice.

9.2 Ofte stillede spargsmal om

SmartControl Lite

SP1. Jeg har udskiftet skermen pa en pc

til en anden skarm, og nu fungerer

SmartControl Lite ikke lengere. Hvad

skal jeg gare?

Sv..  Genstart din pc og se, om SmartControl
Lite fungerer nu. Ellers skal du afinstallere
og geninstallere SmartControl Lite for at
sikre, at den korrekte driver er installeret.

SP2. SmartControl Lite fungerede fint
tidligere, men nu virker programmet
ikke leengere. Hvad skal jeg gore!?

Sv.: Huvis nogle af de felgende handlinger har
varet udfert, skal skeermdriveren maske
geninstalleres.

* Videografikadapteren er blevet udskiftet

med en anden

* Opdater videodriver

» Aktiviteter i OS som f.eks. servicepakke
eller programrettelse

»  Opdater Windows og opdater skaeerm- og/
eller videodriver

*  Windows blev startet med strammen til
skeermen slaet fra eller afbrudt.

* Forat finde ud af dette, skal du klikke
pa My Computer (Denne Computer)
og derefter pa Properties (Egenskaber)
-> Hardware -> Device Manager
(Enhedshandtering).

* Hvis du ser "Plug and Play Monitor” (Plug
& Play skeerm) under Monitor (Skaerm), skal
du geninstallere. Afinstallér SmartControl
Lite og geninstallér det.



SP3.

Sv.:

SP4.

Sv.:

SP5

Sv.:

Efter installation af SmartControl Lite
sker der ingenting, selv om jeg klikker pa
fanen SmartControl Lite og venter, eller
der vises en fejlmeddelelse. Hvorfor?
Det skyldes muligvis, at din grafiske
adapter ikke er kompatibel med
SmartControl Lite. Hvis grafikadapteren
er en af ovennavnte marker; skal

du preve at downloade den mest
opdaterede grafikadapterdriver fra det
pageldende firmas hjemmeside.

Installer driveren. Afinstallér SmartControl
Lite og geninstallér det igen.

Hvis det stadig ikke virker, er vi bange for,
at grafikadapteren ikke understattes. Ga til
Philips hiemmeside og kontrollér, om der
findes en nyere driver til SmartControl Lite.

Nar jeg klikker pa Product Information
(Produktinformation), ses kun nogle af
oplysningerne. Hvad er der sket?

Det kan veere, at din
grafikkortadapterdriver ikke er den

mest opdaterede version, som fuldt ud
understatter DCC/CI greensefladen. Prav
at downloade den mest opdaterede
grafikkortadapterdriver fra det
pageldende firmas hjemmeside. Installer
driveren. Afinstallér SmartControl Lite og
geninstallér det igen.

Attention

Theft mode enabled

Jeg har glemt min PIN-kode til Theft
Deterrence (Anti-tyveri) funktionen.
Hvad gor jeg?

Philips servicecenter forbeholder sig
retten til at bede om legitimation og
godkendelse, for at kunne etablere
skeermens ejer.

Bemaerk venligst at anti-tyveri-funktionen
leveres som gratis ekstraudstyr. Det
eneste ansvar for den individuelle bruger
eller organisation, er at administrere
PIN-koden. Hvis PIN-koden glemmes, kan

Philips kundeservicecenter nulstille koden
for at almindeligt gebyr, nar brugeren har
bekreftet ejerskab af udstyret. Bemeerk
venligst at denne handling ikke er daekket
af standard garantien.

9.3

SP1:

Sv.:

Generelle FAQ

Hvad skal jeg gare, hvis skeermen under
installationen viser “Cannot display
this video mode” (Kan ikke vise denne
videotilstand)?
Den anbefalede oplgsning pa denne
skeerm: 1920x1080@60Hz.
Frakobl alle kabler og forbind derefter
pc'en til skeermen, som du brugte for

I Windows Start Manu (Windows
Startmenuen), veelg Settings/Control Panel
(Indstillinger/Kontrolpanel). I Control Panel
(Kontrolpanel)-vinduet veelg Display (Skaerm)-
ikonet. | Egenskaber for Skeerm-vinduet veelg
“Settings” (Indstillinger) fanebladet. Under
indstillinger-fanen, under feltet “desktop

area” (skrivebordsomrade), skal du stille
justeringsbjaelken pa 1920x1080 pixler:

Abn “Advanced Properties” (Avanceret) og
indstil opdateringshastigheden pa 60Hz og
klik derefter pa OK.

Genstart computeren og gentag trinene
2 og 3 og bekraft, at pc'en er indstillet til
1920x1080@60Hz.

Luk for computeren, frakobl den gamle
skaeerm og genforbind Philips LCD skaermen.

Teend for skeermen og derefter for pc'en.

SP2: Hvad er den anbefalede

Sv.:

SP3:

Sv.:

opdateringshastighed pa LCD skarmen?
Den anbefalede opdateringshastighed

pa LCD skeerme er 60Hz. | tilfeelde af
forstyrrelser pa skeermen skal du satte
den op til 75Hz og se, om dette flerner
forstyrrelserne.

Hvad er .inf og .icm filerne pa cd-
rom'en? Hvordan installerer jeg driverne
(.inf og .icm)?

Dette er skarmens driverfiler. Installer
driverne i henhold til brugervejledningen.



SP4:

Sv.:

SP5:

Sv.:

SPé:

Sv.:

SP7:

Sv.:

SP8
Sv.:

Computeren kan bede dig om
skeermdrivere (inf og .icm filer) eller om en
driverdisk, nar du installerer skeermen farste
gang. Indszt (medfelgende cd-rom) i pakken
i henhold til vejledningerne. Skeermdrivere
(inf og .icm filer) installeres automatisk.

Hvordan justerer jeg oplasningen?
Skaermkortet/grafikdriveren og skaeermen
bestemmer sammen oplgsningerne

til rddighed. Du kan vaelge den

gnskede oplasning under “Display
properties (Egenskaber for Skaerm)” i
Windows® Control Panel (Windows®
kontrolpanelet).

Hvad, hvis jeg “farer vild”, mens jeg
justerer skaermen?

Sa skal du blot trykke pa OK og derefter
vaelge “Reset” (Nulstil) for at ga tilbage il
de oprindelige fabriksindstillinger.

Er LCD-skaermen modstandsdygtig
overfor ridser?

Det anbefales generelt ikke at udseette
skaermens overflade for kraftige stad.
Den er beskyttet mod skarpe og stumpe
ting. Nar du handterer skaermen, sa

pas pa ikke at trykke for kraftigt pa
skeermens overflade. Det kan pavirke
garantibetingelserne.

Hvordan renger jeg LCD skaermens
overflade?

Til normal renggring skal du blot anvende
en ren, blgd klud.Til kraftigere renggring
skal du bruge isopropylalkohol. Brug

ikke andre oplgsningsmidler saisom
ethylalkohol, ethanol, acetone, hexan osv.

: Kan jeg ®ndre skaermens farveindstilling?

Ja, du kan andre farveindstillingen via
OSD pa felgende made:
Tryk pa “OK" for at vise OSD (On Screen
Display) menuen
Tryk pa “Down Arrow” (Ned-pil) for
at veelge indstillingen “Color” (Farve),
og tryk derefter pa "OK" for at angive
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farveindstillingen. Der er tre indstillingen,
som vist nedenfor.

1. Color Temperature (Farvetemperatur) -
Med indstillinger i 6500K omradet virker
skaeermen “varm” med en rgd-hvid
arvetone, mens en 9300K temperatur
giver en "kold bla-hvid farvetone”.

2. sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (f.eks.
digitale kameraer, skeerme printere,
skannere osv).

3. User Define (Brugerdefineret) -
brugeren kan veelge sin foretrukne
farveindstilling ved at indstille den rgde,
grenne og bla farve.

& Bemark

En malning af farven pa lys, der udstréles fra
et objekt, mens det opvarmes. Denne maling
udtrykkes pa en absolut skala (kelvingrader).
Lavere kelvingrader sasom 2004K er rgde,
hgjere temperaturer sasom 9300K er bla.
Neutral temperatur; 6504K; er hvid.

SP9: Kan jeg forbinde min LCD skarm til
enhver pc, arbejdsstation eller Mac?

Ja. Alle Philips LCD skeaerme er fuldt
kompatible med standard pc'er, Mac og
arbejdsstationer. En ledningsadapter kan
vaere ngdvendig for at kunne forbinde
skaermen til dit Mac-system.Vi anbefaler;
at du kontakter Philips salgsrepreesentant
for yderligere oplysninger.

SP10: Er Philips LCD skarme “Plug & Play”?

Sv.:  Ja, skeermene er“Plug & Play” kompatible
med Windows 7/Vista/XP/NT, Mac OSX
og Linux

SP11: Hvad er “billedklabning” eller
“billedindbraending” eller “efterbillede”
eller “spogelsesbillede” pa LCD skarme?
Uafbrudt visning af et stilbillede over
leengere tid, kan forarsage “brandmaerker”,
ogsa kendt som “efterbilleder” eller
“spagelsesbilleder” pa skeermen.

Sv.:

Sv.:



“Breendmeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt
feenomen i LCD skermteknologi. | de
fleste tilfeelde vil “brandmarkerne” eller
“efterbilledet” eller “spggelsesbilledet”
forsvinde gradvist, efter skeermen er
blevet slukket.

Serg altid for at aktivere en pauseskarm,
der bevager sig, nar skaermen efterlades
uden at blive anvendt.

Du skal altid bruge en pauseskaerm

eller et andet program, der opdaterer
skeermen regelmaessigt, hvis LCD
skeermen viser statisk materiale i leengere
perioder.

O Advarsel

Alvorlig “brandmeerkerne”- eller “efterbillede’-
eller “spagelsesbillede”-symptomer forsvinder
ikke og kan ikke repareres. Ovennavnte skade
er ikke daekket af garantien.

SP12: Hvorfor viser skaermen ikke skarp tekst?

Sv.:

Hvorfor viser den forrevne tegn?

Din LCD monitor virker bedst pa dens
native oplgsning pa 1920x1080@60Hz.
Brug denne oplgsning for at opna det
bedste billede.
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